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1 INTRODUCTION

1.1 The Amplicon 200 Series

The Amplicon 200 Series of Personal Computer based data acquisition products provides very 
high performance, affordable hardware with user sympathetic software. The 200 Series is 
designed for users requiring fast or complex data I/O to the host PC and comprises a range of 
boards and software to handle most analog and digital signal types.

When a large scale system is required, multiple boards can be added from the 200 Series without 
conflict. For analog input systems, the capacity of the PC mounted hardware can be extended by 
external expansion panels to provide a convenient to use system with low cost per channel and 
maintained high performance.

1.2 Features of the PCI272

The PCI272 board is designed to meet stringent performance requirements and ease of use. 

72 bit flexible, programmable digital I/O.
Interrupt controlled operations, with the facility for interrupts to be generated.
PCI Bus version 2.1 Plug and play interface.
Device driver software compatible with Windows 95, 98, ME, NT, 2000, and XP.
Linux drivers.
Agilent/HP VEE, Visual Basic and Delphi example software.
Backwards compatible with the PC272E (32 bit).

1.3 General Description

The PCI272 is a plug-in, digital I/O board, which provides 72 bits of parallel digital input/output. 
The board can be used on any PC that supports the PCI bus version 2.1. The card is supplied with 
Windows NT, 95, 98, Me, 2000 & XP compatible device drivers. Linux Comedi drivers are 
available from www.comedi.org

1.3.1 The Software

The PCI272 is supplied with the SOFTMAN CD-ROM. This contains all the software for the card, 
and is documented in the Amplicon ADIO software manual. This manual can be accessed when 
the software is installed from the CD.
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1.4 What the Package Contains 
 

! CAUTION   
 

Some of the components on the board are susceptible to electrostatic discharge, and proper 
handling precautions should be observed. As a minimum, an earthed wrist strap must be 
worn when handling the PCI272 outside its protective bag. Full static handling procedures 
are defined in British Standards Publication BSEN100015/BSEN100015-1:1992. 
 
When removed from the bag, inspect the board for any obvious signs of damage and notify 
Amplicon if such damage is apparent. Do not plug a damaged board into the host computer. 
Keep the protective bag for possible future use in transporting the board. 
 

 
The package as delivered from Amplicon Liveline Ltd. contains:- 
 
1. The plug-in card as ordered, in a protective bag. The PCI272 is identified by the type number 

printed on the board. 
 

PCI272 PCI Bus Digital I/O card  Part Nº 9600 3523 
 
2. Distribution software and manual on CD  Part Nº 8698 6559  v2000A or later 
 
Any additional accessories (mating connectors, software etc.) may be packed separately. 
 

1.5 The Amplicon Warranty Covering the PCI272 
 
This product is covered by the warranty as detailed in the Terms and Conditions stated in the 
current domestic or international Amplicon Liveline catalogue.  
 

1.6 Contacting Amplicon Liveline Limited for Support or Service 
 
The PCI272 boards are designed and manufactured by Amplicon Liveline Ltd and maintenance is 
available throughout the supported life of the product. 
 

1.6.1 Technical Support 
 
Should this product appear defective, please check the information in this manual and the 
Ampdio32manual appropriate to the program in use to ensure that the product is being correctly 
applied. 
 
If a problem persists, please request Technical Support in one of the following ways: 
 

Telephone: UK   
     

Fax:  UK   01273  570 215 
     

Email     support@amplicon.com 

Web:     www.amplicon.co        

0

m

1273 944 835
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It will assist the support engineer if you have the following information available when you call:

Date of purchase
Your account number or postcode 
The Operating System you are running under
The specification of your computer
The nature of your problem and the results of any tests you have conducted
The version number of your Softman CD. 

1.6.2 Repairs

If the PCI272 requires repair then please return the goods enclosing a repair order detailing the 
nature of the fault. If the PCI272 is still under warranty, there will be no repair charge unless any 
damage is a consequence of improper use.

For traceability when processing returned goods, a Returned Materials Authorisation (RMA 
procedure is in operation. Before returning the goods, please request an individual RMA number 
by contacting Amplicon Technical Support by telephone or fax on the above numbers. Give the 
reason for the return and, if the goods are still under warranty, the original invoice number and 
date. Repair turnaround time is normally five working days but the Service Engineers will always 
try to co-operate if there is a particular problem of time pressure.

Please mark the RMA number on the outside of the packaging to ensure that the package is 
accepted by the Goods Inwards Department. 

Address repairs to: Customer Services Department
AMPLICON LIVELINE LIMITED
Centenary Industrial Estate
Brighton, East Sussex
BN2 4AW
England
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2 GETTING STARTED

2.1 General Information

The PCI272 cards are Plug and Play compatible and come complete with all the software required 
to install and operate the card in any PCI version 2.1 compliant host PC running under Windows 
95, 98, Me, NT, 2000, or XP and allow full card functionality.

2.2 Host Computer Requirements

When installing one or more PCI272 series boards, ensure that the host computer has sufficient 
capacity. Take into account other boards or adapters that may be installed in the computer when 
assessing physical space, address space in the I/O map, interrupt levels and the power 
requirements.

This board is suitable for use in any PC compatible computer that can provide a single PCI Bus 
version 2.1 slot, with sufficient space for a half-length card.

The computer must run under one of the following operating systems. Windows95, Windows 98, 
Windows Me, Windows NT 4.0, Windows 2000, or Windows XP.

2.3 Installing the Board

ENSURE THAT THE POWER TO THE COMPUTER IS SWITCHED OFF BEFORE 
INSTALLING OR REMOVING ANY EXPANSION BOARD. OBSERVE HANDLING 
PRECAUTIONS NOTED IN SECTION 1.4.

REPAIR OF DAMAGE CAUSED BY MIS-HANDLING IS NOT COVERED UNDER 
THE AMPLICON WARRANTY.

DO NOT MAKE ANY MODIFICATIONS TO A BOARD THAT IS ON EVALUATION

Please refer to the manufacturer's hardware manual supplied with the PC for instructions on how
to remove the cover and install devices into a PCI slot. The PCI272 may be installed in any 
available position in the machine provided that there is no restriction specified for that location by 
the computer manufacturer.

The PCI272 board is a Plug and Play device. The installation software supplied will handle the 
configuration of the card.

When the board is physically installed in the PC, and the PC is rebooted, The Windows 95, 
Windows 98, Windows Me, Windows 2000, or Windows XP operating system will detect new 
hardware and prompt for installation of the device drivers. Windows NT 4.0 will not be aware of the 
board until the drivers have been installed.
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2.4 Software Installation

Please refer to the ADIO software manual, ampdio32manual.pdf, for the latest Windows 32-bit 
driver installation information.

2.4.1 Windows 95/98/Me Installation

The Windows 95 drivers supplied with this card are compatible with installation and operation 
under Windows 98 and Windows Me.

To install the drivers under Windows 95:

1. Turn on the PC and allow the operating system to discover new hardware. Insert the 
SOFTMAN CD into the CD-ROM drive and click the ‘Next’ button on the first ‘Update Device 
Driver Wizard’ dialog.

2. If Windows fails to find the correct INF file automatically, click on the ‘Other Locations’ button, 
browse to the top-level directory of the SOFTMAN CD and click ‘OK’.

3. Windows should correctly identify the board as a PCI272. Click the ‘Finish’ button.

4. Windows will now proceed to copy the driver software from the CD. If Windows asks for the 
‘Amplicon DIO Drivers Disk’ to be inserted, ensure the SOFTMAN CD is in the drive, click 
‘OK’, click ‘Browse’, browse to the top-level directory of the SOFTMAN CD (which contains the 
file Windows is trying to find) and click ‘OK’.

To install the example software, rerun Amplicon Softman CD and select the 'Access your manual 
and software' button, and then double click on the '32 bit'' software button for the PCI272. This will 
extract and run file AMPDIO.EXE on the SOFTMAN CD. Follow the instructions to install the 
samples onto your PC. 

To install the drivers under Windows 98 or Windows Me:

1. Turn on the PC and allow the operating system to discover new hardware. Insert the 
SOFTMAN CD into the CD-ROM drive. On the ‘Add New Hardware Wizard’ dialog, select the 
‘Search for the best driver for your device’ option and click ‘Next’.

2. Make sure the ‘CD-ROM drive’ option is checked and click ‘Next’. If Windows fails to find the 
correct INF file, click ‘Back’, select the ‘Specify a location’ option, click the ‘Browse’ button, 
browse to the top-level directory of the SOFTMAN CD and click ‘OK’.

3. Windows should correctly identify the board as a PCI272. Click ‘Next’.

4. Windows will process to copy the driver software from the CD. When it has finished, click the 
‘Finish’ button.

To install the example software, rerun Amplicon Softman CD and select the 'Access your manual 
and software' button, and then double click on the '32 bit' software button for the PCI272. This will 
extract and run file AMPDIO.EXE on the SOFTMAN CD. Follow the instructions to install the 
samples onto your PC. 



PCI272

Page 10

2.4.2 Windows NT4.0 Installation

Please ensure that PLUG n PLAY OS (or equivalent) option on the BIOS settings screen is set to 
NO or OFF.

The driver is installed as part of the set-up process for the remaining software.

1. To install the example software, rerun Amplicon Softman CD and select the 'Access your 
manual and software' button, and then double click on the '32 bit' software button for the 
PCI272. This will extract and run file AMPDIO.EXE on the SOFTMAN CD. Follow the 
instructions to install the samples onto your PC. 

2. After rebooting the PC, the PCI272 will be detected by the installed driver and configured 
automatically.

3. The Amplicon DIO control panel applet can be used to verify that the board has been 
detected. This will also show the base address and IRQ settings for the board.

2.4.3 Windows 2000/XP Installation

For versions of the AMPDIO software prior to 4.32, please follow the instructions for installing a 
card in Windows NT 4.0 (see section 2.4). For versions 4.30 and 4.31, the supplied 
AMPDIOV4.INF file will allow the supported PCI cards to appear under Device Manager, but these 
are just dummy entries. For versions prior to 4.30 the supported PCI cards will appear as unknown 
devices under Device Manager.

For AMPDIO software versions 4.32 and later, a ‘Plug and Play’ Windows 2000 driver is used. This 
section describes how to install a PCI card to use this Plug and Play driver under Windows 2000.

To install the drivers under Windows 2000:

1. Turn on the PC and allow the operating system to discover new hardware. Insert the 
SOFTMAN CD into the CD-ROM drive. If Windows opens the ‘Welcome to the Found New 
Hardware Wizard’ page, press ‘Next’ and go to step 2. If Windows just asks for a disk labelled 
‘Amplicon DIO Drivers Disk’ go to step 5.

2. Select the ‘Search for a suitable driver for my device (recommended)’ option and press ‘Next.

3. Check the ‘CD-ROM drives’ option. Press ‘Next’.

4. On the ‘Driver Files Search Results’ page, Windows should say ‘Windows found a driver for 
this device’.  Press ‘Next’.

5. If Windows asks for a disk labelled ‘Amplicon DIO Drivers Disk’ when trying to copy files, click 
‘OK’ to cancel the alert box, then browse to the root directory on the CD-ROM and press 
‘Open’, then ‘OK’. Windows will copy the files and install the driver.

6. On the ‘Completing the Found New Hardware’ screen, Windows should correctly identify the 
device as a PCI272. Press ‘Finish’
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To install the drivers under Windows XP:

1. If installing from CD-ROM rather than from the self-extract target directory, ensure the 
Amplicon SOFTMAN CD-ROM is in the CD-ROM drive.

2. When Windows detects the new hardware and opens the 'Welcome to the Found New 
Hardware Wizard' page, press 'Next'.

3. If installing from the CD-ROM, select the 'Install the software automatically (Recommended)' 
option. If installing from the self-extract target directory, select the 'Install from a list or specific 
location (Advanced)' option. Press 'Next'.

4. If installing from the self-extract target directory, select the 'Search for the best driver in these 
locations' option, deselect the 'Search removable media (Floppy, CD-ROM...)' option, select 
the 'Include this location in the search' option, press the 'Browse' button and browse to the 
self-extract target directory. Then press 'Next'.

5. Windows will install the driver and reach the 'Completing the Found New Hardware Wizard' 
page.

6. On the 'Completing the Found New Hardware Wizard' page, press 'Finish'.

To install the example software, rerun Amplicon Softman CD and select the 'Access your manual 
and software' button, and then double click on the '32 bit' software button for the PCI272. This will 
extract and run file AMPDIO.EXE on the SOFTMAN CD. Follow the instructions to install the 
samples onto your PC. 

2.5 Application Software

Example application software, including source code for the applications and the DLL are supplied 
in the self-extracting archive AMPDIO.EXE along with the SETUP program. When the self-
extracting archive is run and software is extracted to a suitable directory (e.g. 
C:\AMPLICON\AMPDIO), the examples and DLL source code can be found in subdirectories off 
this directory. The software supplied with this card supports operation with Windows 95, 98, Me, 
2000 & NT 4.0 only. Refer to the AMPDIO W32 DRIVERS document (ampdio32manual.pdf) for 
details.
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2.6 Installation Testing

Ensure the PC and BIOS are PCI 2.1 compliant 

2.6.1 Verifying Installation for Windows 95/98/Me

To verify the correct driver has been installed:

(a) Use Windows Explorer to browse to the <WINDOWS>\system directory.
(b) Click on the AMPDIO.VXD file and select ‘Properties’ from the explorer ‘File’ menu.
(c) Click on the ‘Version’ tab on the properties dialog box.
(d) Verify that the file version is at least 4.30.

To verify the card has been detected:

(a) Open the Control Panel, e.g. via ‘Start’ -> ‘Settings’ -> ‘Control Panel’.
(b) Double click the ‘System’ icon (or open it from the Control Panel’s File menu).
(c) On the System Properties dialog box, click the ‘Device Manager’ tab.
(d) Click the ‘View devices by type’ radio button if this is not already selected.
(e) Look for and select the PCI card under the branch labeled ‘Amplicon Analogue/Digital IO 

Counter Timer Cards’.
(f) Check the device status message box to make sure the device appears to be working 

correctly.
(g) Click the ‘Properties’ button.
(h) On the properties dialog box, check there are no resource conflicts and that the PCI card has 

been assigned an IRQ.

2.6.2 Verifying Installation for Windows NT 4.0

Please verify that the Windows NT build is at least 1381 (Service Pack 3). Ensure that the card 
has been correctly inserted into a slot on the PC’s PCI bus and the PC has been rebooted.

To verify the correct driver has been installed:

(a) Use Windows NT Explorer to browse to the <WINDOWS>\system32\drivers directory.
(b) Click on the AMPDIO.SYS file and select to ‘Properties’ from the Explorer ‘File’ menu.
(c) Click on the ‘Version’ tab on the properties dialog box.
(d) Verify that the File version is at least 4.30.

To verify the correct control panel extension has been installed:

(a) Use Windows NT Explorer to browse to the Windows\system32 directory.
(b) Click on the AMPDIO.CPL file and select ‘Properties’ from the Explorer ‘File’ menu.
(c) Click on the ‘Version’ tab on the properties dialog box.
(d) Verify that the file version is at least 2.2.0.0.

To verify that the driver is running:

(a) Open the Control Panel, e.g. via ‘Start’ -> ‘Settings’ -> ‘Control Panel’.
(b) Double click the ‘Devices’ icon (or open it from the Control Panel’s File menu).
(c) Look down the list for the device called ‘AmpDIO’ and verify that its status is ‘Started’.
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To verify that the driver has recognised the card:

(a) Open the Control Panel, e.g. via ‘Start’ -> ‘Settings’ -> ‘Control Panel’.
(b) Double click the ‘Amplicon DIO’ icon (or open it from the Control Panel’s File menu).
(c) Select each of the ‘DIOn’ entries from the list in turn. For each selected entry, click the 

‘Settings’ button.
(d) For one of the listed DIOn entries, the dialog box which pops up should list the PCI card type, 

its location on the PCI bus (e.g. 0/20) and a status in square brackets. If the status says ‘[OK]’, 
then a card of the indicated type has been detected at the indicated location on the PCI bus.

N.B.:

(a) If any of the DIOn entries correspond to ISA cards, a different dialog box will be shown 
when ‘Settings’ is clicked for that entry.

(b) If there are 8 DIOn entries DIO0 through DIO7 and the new card does not appear to be 
amongst them or appears to be marked ‘[BAD]’. The new card may have been detected 
but not used by the driver. Try deleting one of the DIOn entries. If the ‘Add PCI’ button 
becomes active, click it and see if the new card appears in the drop-down list of cards.

(c) PCI cards will also be marked ‘[BAD]’ if the driver has not been started since the system 
was last rebooted (e.g. if has been set to start manually).

2.6.3 Verifying Installation for Windows 2000

To verify the correct driver has been installed:

(a) Use Windows 2000 Explorer to browse to the <WINDOWS>\system32\drivers directory.
(b) Click on the AMPDIO2K.SYS file and select ‘Properties’ from the explorer ‘File’ menu.
(c) Click on the ‘Version’ tab on the properties dialog box.
(d) Verify that the file version is at least 4.32.
(e) Use Windows 2000 Explorer to browse to the <WINDOWS>\system32 directory.
(f) Click on the AMPDIOCO.DLL file and select ‘Properties’ from the explorer ‘File’ menu.
(g) Click on the ‘Version’ tab on the properties dialog box.
(h) Verify that the file version is at least 4.32.

To verify the card has been detected:

(a) Open the Control Panel, e.g. via ‘Start’ -> ‘Settings’ -> ‘Control Panel’.
(b) Double click the ‘System’ icon (or open it from the Control Panel’s File menu).
(c) On the System Properties dialog box, click the ‘Hardware’ tab and press the ‘Device 

Manager’ button.
(d) On the Device Manager dialog box, ensure the ‘Devices by type’ option is selected on 

the ‘View’ menu.
(e) Look for and select the PCI card under the branch labeled ‘Amplicon Analogue/Digital IO 

Counter Timer Cards’.
(f) Double click on the selected card (or select ‘Properties’ on the File menu).
(g) Check the device status message box to make sure the device appears to be working 

correctly.
(h) Click the ‘Settings’ tab and check that the card has been assigned a DIO port number in 

the range DIO0 to DIO7.
(i) Click the ‘Resources’ tab, check there are no resource conflicts and that the PCI card 

has been assigned an IRQ.
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2.6.4 Verifying Installation for Windows XP

To verify the correct driver has been installed:

(a) Use Windows Explorer to browse to the <WINDOWS>\system32\drivers directory.
(b) Click on the AMPDIO2K.SYS file and select 'Properties' from the explorer 'File' menu.
(c) Click on the 'Version' tab on the properties dialog box.
(d) Verify that the file version is at least 4.32.
(e) Use Windows Explorer to browse to the <WINDOWS>\system32 directory.
(f) Click on the AMPDIOCO.DLL file and select 'Properties' from the explorer 'File' menu.
(g) Click on the 'Version' tab on the properties dialog box.
(h) Verify that the file version is at least 4.32.

To verify the card has been detected:

(a) Open the Control Panel, e.g. via 'Start' -> 'Control Panel' -> 'Performance and Maintenance'.
(b) Double click the 'System' icon.
(c) On the System Properties dialog box, click the 'Hardware' tab and press the 'Device Manager' 

button.
(d) On the Device Manager dialog box, ensure the 'Devices by type' option is selected on the 

'View' menu.
(e) Look for and select the PCI card under the branch labelled 'Amplicon Analogue/Digital IO 

Counter Timer Cards'.
(f) Double click on the selected card (or select 'Properties' on the File menu).
(g) Check the device status message box to make sure the device appears to be working 

correctly.
(h) Click the 'Settings' tab and check that the card has been assigned a DIO port number in the 

range DIO0 to DIO7.
(i) Click the 'Resources' tab, check there are no resource conflicts and that the PCI card has 

been assigned an IRQ.
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2.7 Digital I/O

The PCI272 has three 82C55 Programmable Peripheral Interface (PPI) chips with all functions of 
ports A and B, and optionally port C, available to the user. The operational mode for each port is 
established by writing to the control register of the 82C55. The 24 I/O pins of each user PPI are 
brought out to the D-type connector, and can be used to control other external devices, or to 
accept control inputs from an external device. Some port C lines can be shared with other 
functions.

The control word written to the 82C55 control register also establishes whether the port is 
configured to operate as input, output or bi-directional. The control word is 8 bits and has two 
formats. When bit 7 is set to 1, the control word is used to establish the operational modes for the 
ports. When set to 0, the control word is used to write bits to Port C for status/control purposes.

The digital I/O facility of the PCI272 provides 72 lines in three clusters of three 8 bit ports, labelled: 
DIO Port XA0 - XA7, DIO Port XB0 - XB7 and DIO Port XC0 - XC7;
DIO Port YA0 - YA7, DIO Port YB0 - YB7 and DIO Port YC0 - YC7.
DIO Port ZA0 - ZA7, DIO Port ZB0 - ZB7 and DIO Port ZC0 - ZC7.

Each cluster is divided into two groups of 12 bits each. Group A comprises the 8 bits of port A and 
the high order 4 bits of port C. Group B comprises the 8 bits of port B and the low order 4 bits of 
port C. When port C is split in this mode, a nibble (four bits) of data read from or written to port C 
occupies the appropriate high or low end of a full byte, the other four bits not being used.

Full details of programming the 82C55 PPI at register level, in its various modes, are shown in the 
device specification in Appendix App82C55.pdf in the \MANUAL subdirectory on the Amplicon 
SOFTMAN CD-ROM. The three basic operating modes are summarised below.

Mode 0 (Basic I/O)

This mode is the power-up default with all ports set as input (i.e. high impedance).

In mode 0, the PPI provides simple I/O operations. No control signals are required 
and the ports defined as input reflect the current state of digital signals on the 
lines  (no latching). The lines of output defined ports are set to zero on the 
mode change, and when a port is loaded, the outputs are latched to that value

All 24 bits can be used for input or output arranged as any combination of two 8 bit 
ports and two 4 bit ports.

Mode 1 (Strobed I/O)

Mode 1 provides I/O operations on Group A and/or Group B each with a simple 
handshake protocol. In either group, the 4-bit port is used for status and control 
of the associated 8-bit port. An IRQ facility in this mode is available on the 
PCI272.

Each 8-bit port can be used uni-directionally for either input or output operations, both 
being latched.

Mode 2 (Strobed Bi-directional I/O)

This mode of operation can be applied to group A only, and provides one 8 bit bi-
directional data port and one 5 bit control and status port with IRQ facility. Both 
input and output operations are latched. Port B can be used in mode 0 or 1 
while port A is in mode 2.
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Mixed Mode

The ports of the PPI can be programmed to operate in a mixed combination of modes 
that in some cases leave bits of port C unused for control or status purposes. 
These unused bits can be programmed for use as inputs or outputs.

2.8 Digital I/O Conditions

The digital I/O lines on ports A, B and C of clusters X, Y and Z, are TTL compatible.

When an input line is left open circuit, its high input impedance makes it susceptible to static 
charge and interference and the state may be indeterminate. Ensure that signals to any inputs are 
within the above limits, and that any unused input lines are grounded or masked out in software. 

2.9 Intersil 82C55 differences from Oki 82C55

In order to meet RoHS compliance, the OKI 82C55 chip originally fitted on non-RoHS compliant 
revisions of this board has been replaced with an Intersil 82C55 chip. The Intersil 82C55 has an 
added feature to the I/O buffer called Bus Hold which can hold either a 0 or 1 depending on the 
circuitry attached. This element will remember the last value that line was driven to and will try to 
hold that value by driving the line weakly (similar to a bias resistor).

The bus hold feature affects the behavior of the device when its data lines are configured as 
inputs. When a digital I/O line is configured as input, its value is normally defined by the input 
signal. When there is no signal, then the value can be defined using bias resistors (a pull up will 
define a ‘1’ value, and a pull down resistor will define a ‘0’ value). 

Users of the PCI272 may need to review their input drive circuits to ensure they can source / sink 
sufficient current to overcome the ‘bus hold current’ of the Intersil 82C55.

The PCI272 card has always been fitted with pull-up resistors. On power up all the I/O lines default 
to inputs and therefore all the I/O pins will be pulled high until configured as inputs or outputs by 
the system software.

If users need to ensure that any of the I/O pins are low at power up, they need to provide the 
means externally to ensure that the line is pulled down with low enough resistance to overcome 
the bus hold current and pull-up resistor.

Because the bus hold currents are quite strong, existing pull downs may not be strong enough to 
overcome the bus hold feature.

The bus hold feature may have unwanted effects on your implementation, if:

At power up the I/O lines need to be in a low state
Pull down resistors are used to hold the I/O line in a known state. 
Input driving circuits have insufficient current source / sink capability.

In all other cases, the application should NOT be affected by this specification change.

The bus hold implementation on Port A is different to that used on ports B and C.

Port A Bus Hold

The bus hold circuit on Port A of the Intersil 82C55 can hold a high or low state and is active as 
long as the line is configured as an input. If the line is changed from an output to an input, the most 
recent value written to the line will determine whether the bus hold circuit pulls the line high or low.
If the last value written was a “high”, the bus hold will try to keep the high value. If the last value 
written was a “low”, the bus hold will try to keep the low value.
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The PCI272 now card has strong 4.7 kohm pull ups fitted to port A in sockets, to overcome the bus 
hold facility and force the input to “high”. The user will need to check that the device driving the line 
is capable of sourcing / sinking the new higher current.

Special care is needed if open collector drivers are used. Open collector drivers actively drive a 0 
to the line, but rely on a pull up resistor in order to drive a 1. The 4.7 kohm pull-up resistor on the 
PCI272 will appear in parallel with any external pull-up, increasing the current sink requirement of 
the driver.

sink current = (VCC – 0.8)   + 1.3 mA
     Rext_pullup

Where Rext_pullup  is the value of any external pull-up resistance fitted, and VCC is the input voltage.

If external pull-down resistors are used to hold the line low then the value of the pull down resistors
will need to be low enough to overcome the bus hold current. The sockets allow users to remove 
the 4.7 kohm pull-up resistors, when not required. The hold current is strong ( 400 A maximum) 
so the pull down resistors need to be less than 1.7 kohm.

If series resistors are used on the outputs of devices driving the data inputs then these resistors 
values will also need to be reduced.

Port B and C Bus Hold

The bus hold circuit on ports B and C of the Intersil chip can only hold a high state (‘1’) and is only 
active from the time the line is configured as an input until the line recognizes a low value on the 
input. Once the line is driven to a low value (by some external device), the bus hold for that line is 
disabled and will not be enabled again until the port is reconfigured as an input. If the last value 
driven to the line was high, the bus hold will try to keep the value high, so the line will remain high 
when no driver is actively driving it. 

The PCI272 card has always had weak 100 kohm pull ups fitted ensuring that the input will default 
to a high unless driven low by an external circuit. 

If external pull down resistors are used to hold the line low then the value of the pull down resistors 
will need to be low enough to overcome the bus hold current. The hold current is strong ( 400 A
maximum) so the pull down resistors need to be less than 1.7 kohm.

As this is a new feature of the 82C55, both new and existing users of the PCI272 need to review 
their input drive circuits to ensure they can source / sink sufficient current to overcome the ‘bus 
hold current’.
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2.10 Digital I/O Connections

The three clusters of three ports of the PPI are all terminated on the rear 78 way D type connector 
SK1. Pin-outs are shown in Figure 3.1. A connector kit part number 9194 5953 is available from 
Amplicon.

2.11 The PCI Interface

The PCI272 is a PCI bus slave card. Communication between the host PC and the PCI272 DIO 
board is via the PCI bus. This bus provides data, address, interrupt and control lines together with 
the power supply for the PCI272.

The PCI272 is allocated one Base Address (BA) in the available I/O space.

The board base address and PC IRQ are set up by the PCI enumerator software during 
installation. Interrupt sources are classified by the position in an interrupt source register and each 
source is maskable by a bit in an interrupt mask register.

The PCI272 uses only the +5 V supply from the host PC and this supply rail is also available for 
external use via the I/O connector.
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ADDRESS PC272E Write/Read Bits Group

BA + 00 PPI X Port A Write/Read 8
BA + 01 PPI X Port B Write/Read 8
BA + 02 PPI X Port C Write/Read 8
BA + 03 PPI X Control Write/Read 8 Cluster
BA + 04 Write/Read 8 X
BA + 05 Write/Read 8
BA + 06 Write/Read 8
BA + 07 Write/Read 8
BA + 08 PPI Y Port A Write/Read 8
BA + 09 PPI Y Port B Write/Read 8
BA + 0A PPI Y Port C Write/Read 8
BA + 0B PPI Y Control Write/Read 8 Cluster
BA + 0C Write/Read 8 Y
BA + 0D Write/Read 8
BA + 0E Write/Read 8
BA + 0F Write/Read 8
BA + 10 PPI Z Port A Write/Read 8
BA + 11 PPI Z Port B Write/Read 8
BA + 12 PPI Z Port C Write/Read 8
BA + 13 PPI Z Control Write/Read 8 Cluster
BA + 14 Write/Read 8 Z
BA + 15 Write/Read 8
BA + 16 Write/Read 8
BA + 17 Write/Read 8
BA + 18 Write 8
BA + 19 Write 8 Counter
BA + 1A Write 8 Connections
BA + 1B Write 8 Registers
BA + 1C Write 8
BA + 1D Write 8
BA + 1E Int’s enable/stat Write/Read 6 Interrupts
BA + 1F Spare

FIGURE 2.1 PCI272 REGISTER ASSIGNMENTS

2.12 IER Interrupts Enable / Status Register

This is a read and write register. When written to it is an interrupt enable / mask register. Set the 
relevant bit high to enable any particular interrupt. When read it is the interrupt status register. If 
enabled and active prior to reading the ISR the corresponding bit will be set.

7 6 5 4 3 2 1 0
0 0

PPI X Port C bit 0
PPI X Port C bit 3
PPI Y Port C bit 0
PPI Y Port C bit 3
PPI Z Port C bit 0
PPI Z Port C bit 3
Reserved
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3 ELECTRICAL CONNECTIONS

This chapter describes the signal and control connections that the user must make between the 
PCI272 and any external devices. These I/O connections are made through the D-type connector 
protruding from the PC adapter slot corresponding to the chosen board position. The metal shell 
connected to the local PC chassis ground. All signals are referred to the relevant signal ground.

3.1 78 way D-type Connector (SK1 - User I/O)

Connections from the PCI272 to the user devices are made via a 78 way D-type connector.  The 
pin assignments for this connector are shown in Figure 3.1.

7132
5213

7031
5112

6930
5011

6829
4910

6728
489

6627
478

6526
467

6425
456

6324
445

6223
434

6122
423

6021
412

401

7738
5819

7637
5718

7536
5617

7435
5516

7334
5415

7233
5314

7839
5920

C
L
U
S
T
E
R

X

C
L
U
S
T
E
R

Z

C
L
U
S
T
E
R

Y

PPI.Z.Port.B1
PPI Z Port B0

PPI X Port B1

PPI.X.Port.C4

PPI X Port A6
+5VDC O/P

PPI X Port A2
PPI X Port A4

PPI X Port A0
PPI X Port C6

PPI X Port C3
PPI X Port C1
PPI X Port B7

PPI X Port B3
PPI X Port B5

PPI X Port A3
PPI X Port A5
PPI X Port A7

PPI X Port C7
PPI X Port A1

PPI X Port C5

PPI X Port C2
GND

PPI X Port B6
PPI X Port C0

PPI X Port B2
PPI X Port B4

PPI Y Port C5

PPI Y Port A7
PPI X Port B0

PPI Y Port A3
PPI Y Port A5

PPI Y Port A1
PPI Y Port C7

GND
PPI Y Port C2
PPI Y Port C0

PPI Y Port B2
PPI Y Port B4
PPI Y Port B6

PPI Y Port A4
PPI Y Port A6
GND

PPI Y Port A0
PPI Y Port A2

PPI Y Port C6

PPI Y Port C3
PPI Y Port C4

PPI Y Port B7
PPI Y Port C1

PPI Y Port B3
PPI Y Port B5

PPI.Z.Port.C6

PPI Z Port B2

GND
PPI Y Port B1

PPI Z Port A4
PPI Z Port A6

PPI Z Port A2
PPI Z Port A0

PPI Z Port C4
PPI Z Port C3
PPI Z Port C1

PPI Z Port B3
PPI Z Port B5
PPI Z Port B7

PPI Z Port A5
PPI Z Port A7
PPI Y Port B0

PPI Z Port A1
PPI Z Port A3

PPI Z Port C7

GND
PPI Z Port C5

PPI Z Port C0
PPI Z Port C2

PPI Z Port B4
PPI Z Port B6

FIGURE 3.1 78 WAY D-TYPE CONNECTOR (SK1 - USER I/O)
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Connection accessories are available from Amplicon:

Description Order Code

EX233 termination and distribution panel (& manual) 9096 6333
EX213 24 channel output panel with relays and 9096 6363

Isolated logic panel
EX230 24 channel input panel with isolated, common 9096 6373

& contact closure inputs 

78 pin connector kit 9194 5953
78 way cable (1m) EX233 interconnect cable 9096 6349
37 way screened cable 9101 4890

The full details of these termination panels are available on our web site www.amplicon.co.uk

3.2 Voltage Outputs Available on SK1

In addition to the 72 digital I/O lines, the +5VDC PC voltage rail is brought out on SK1, the I/O 
connector. No more than 1.0 Amp should be drawn from the +5V rail. Refer to the computer 
technical reference manual for current availability from the source power supplies. 

3.3 Use of Shielded Cables

In order to maintain compliance with the EMC directive, 89/336/EEC, it is mandatory that the final 
system integrator uses good quality screened cables for external connections.  It is up to the final 
system integrator to ensure that compliance with the Directive is maintained.  Amplicon Liveline 
offers a series of good quality screened cables for this purpose.  Please contact our sales staff.
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4 PROGRAMMING THE PCI272

The PCI272 is supplied with Windows 95, Windows NT, Windows 2000 and Windows XP specific 
drivers. The Windows 95 driver is also compatible with Windows 98 and Windows Me. 
Programming for use under other operating systems is beyond the scope of this manual. A 
Dynamic Link Library (DLL) is supplied to provide an Application Programming Interface (API) for 
user programs.

4.1 Copyright

Software supplied with the PCI272 is Amplicon copyright. Permission is granted for the purchaser 
of the PCI272 to incorporate any part of the Amplicon copyright software into related application 
programs, and to use, resell or otherwise distribute such application programs for operation with 
PCI272 hardware purchased from Amplicon Liveline Limited.

4.2 Guide to User Programming

When developing an application specific program, it is advised that the supplied driver and 
dynamic link library functions be used for 32-bit Windows applications. Please refer to the ADIO 
software manual, ampdio32manual.pdf, for details of programming using the functions in the 
DLL.

The relevant sections in the Win32 Drivers manual are as follows:

1 INTRODUCTION
2 GETTING STARTED
3 DRIVER FUNCTIONS AND CONCEPTS, introductory section
3.2 Digital I/O Functions
3.4 Using Interrupts
4 SOFTWARE INSTALLED WITH THE DRIVER
5 STRUCTURE AND ASSIGNMENTS OF THE REGISTERS
5.4.1 82C55 Programmable Peripheral Interface Registers
6 PROGRAMMING WITH THE ADIO DRIVER
6.3 Using the Dynamic Link Library
6.4 Windows 32 Library Functions
6.4.1 Initialization Functions
6.4.2 Interrupt Control Functions
6.4.3 Thread Priority Functions
6.4.11 Digital Input/Output Functions
6.4.12 Switch Scanner Matrix Functions
6.4.13 Basic User Interrupt Callbacks
6.4.14 Buffered User Interrupt Callbacks
6.4.15 Non-Callback Buffered User Interrupts
6.4.23 Driver Interface Functions
6.5 Library Error Codes
7 IOCTL Interface

For programming at register level, reference should to be made to section 2 describing the 
assignments of each I/O register in the PCI272. Support is not available for this method of 
programming.
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4.3 Interfacing with Commercial Software Packages

The supplied software examples are not intended to be stand alone applications programs, other 
than for demonstration and test purposes. To meet most user requirements, either a dedicated
program must be written using the functions and examples provided or the PCI272 can be 
interfaced to a commercial applications package.

Other Applications Packages

Further interface packages to commercial software will be made available as requirements
expand. Check the 'README' files on the distribution CD, and/or the Amplicon Product 
Catalogue or Sales Department for the latest information.

4.4 Notes for Users of the PC272E

The PCI272 is a PCI bus compatible replacement for the PC272E ISA Digital I/O card. Where the 
PCI272 is used in systems previously using the PC272E, the user should note the following.

Base Address and IRQ

The I/O Base address and IRQ are assigned by the PC Plug and Play BIOS, rather than being set 
by jumpers. These tend to get reassigned by the BIOS when PCI hardware is added or removed.

If using the supplied Windows 32-bit driver and DLL, calls to the registerBoard function should be 
replaced by calls to registerBoardEx or registerBoardPci which do not rely on the base address or
IRQ remaining fixed. Please refer to the ADIO software manual, ampdio32manual.pdf, for details.

Interrupt Sharing

The PCI272 interrupts are level-sensitive and the IRQ is usually shared by other PCI cards. The 
PCI272 asserts the interrupt while its interrupt status register at BA + 1E is non-zero, indicating 
that an enabled interrupt condition has occurred and has not yet been cleared.

An interrupt routine for the PCI272 should check the card's interrupt status register to see if it is 
asserting the interrupt.

PC272E

The PCI272 provides the same functions as the PC272E.

If using the supplied Windows 32-bit driver and DLL note the following:

1. If using the registerBoard or registerBoardPci functions, the card type PCI272 (=272) may be 
used instead of PC272E (=272). They have the same numeric value.
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APPENDICES

APPENDIX A TECHNICAL SPECIFICATIONS

A.1 Electrical Specification

DIGITAL I/O

Digital I/O Ports 72 I/O lines arranged as three clusters (X, Y and Z) of three 8 bit ports 
(A, B and C).

Each cluster also programmable as two groups of 12 bits (group A, 
group B) and used in three modes of operation. Each Control block 
(Group A and Group B) accepts "commands" from the Read/Write 
Control logic, receives "control words" from the internal data bus and 
issues proper commands to its associated ports.

Control Group A - Port A and Port C upper (C7 - C4)
Control Group B - Port B and Port C lower (C3 - C0)

Mode 0: Basic I/O (Group A, group B)
Mode 1: Strobed I/O (Group A, group B)
Mode 2: Bidirectional bus (Group A only)

Digital Inputs 'Low' input voltage -0.3V to +0.8V. )        TTL
'High' input voltage +2.2V to +5.3V. ) compatible

Digital Outputs 'Low' output voltage, +0.4V max at 2.5mA
'High' output voltage, +3.7V min at -2.5mA.

User I/O Connector 78 way male D-sub. 

Address Range The board’s address range is assigned by the plug and play mechanism.

IRQ Range Port C3 Interrupt is assigned an IRQ by the plug and play mechanism.

Power Powered by +5 Volts from the host PC bus.

PCI272 draws 120mA or up to 300mA when all 72 digital output lines are 
fully loaded.

+5 VDC at 1A PC bus voltage is available at the user I/O connector:

A.2 Software Specification

The distribution software is supplied on a CD-ROM.

Windows 95, 98, NT, 2000 & XP Driver Software provides 
Application level access to all the advanced features of the card 
from these operating systems.
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A.3 Environmental Conditions

Environment

The PCI272 is designed to operate in a PC/AT environment.  Particular attention is paid at the 
design stage to minimise emission of noise and susceptibility to external radiated noise. 

Specific conditions

I/O Positions Required One PCI bus version 2.1 I/O adapter slot with room for half-length 
card.

Board Dimensions Length 145 mm
Height 108 mm plus edge connectors.

Temperature Range Operating 0° C to +60° C
Storage -20 to +70° C

Humidity Range 5% to 95% non-condensing 

Power Requirements 5 VDC from host computer power supply.

200 mA  PCI272 typical operating

Excluding power supplied to external system via user connector.

Dissipation Each PCI272 will dissipate typically 1.0 Watt of heat 

Handling Normal static handling precautions apply.  Damage could result if 
not observed

Order Codes

The Order Code for the PCI272 is 9600 3523

Optional Accessories

Amplicon 
Order Code

Description

9096 6333 EX233 termination and distribution panel (& manual)
9096 6363 EX213 24 channel output panel with relays and 

Isolated logic panel
9096 6373 EX230 24 channel input panel with isolated, common 

& contact closure inputs
9194 5953 78 pin connector kit
9096 6349 78 way interconnect cable (1m) for EX233
9101 4890 37 way screened cable
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APPENDIX B CIRCUIT LAYOUT AND SCHEMATIC DRAWINGS

Full circuit diagrams and layout drawings of the PCI272 are given in this appendix.

B.1 ASSEMBLY DETAIL

FIGURE B.1 PRINTED CIRCUIT LAYOUT
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